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Introduction 

This booklet aims to explain in plain language how to make 

your documents accessible to as many people as possible. 

By ‘accessible’ we mean presenting information in a way 

that makes it easy to read and understand. This may be for 

people with a learning disability or a visual impairment. 

 

Why make documents accessible? 

It is in your best interest to ensure your materials are 

understood by a wide audience. Those who have difficulty 

reading can be easily overlooked and missing out on 

valuable opportunities. 

This booklet focuses on Microsoft Word, but its principles 

extend to emails and PowerPoint presentations too. 
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Make Your Word Documents Accessible 

Please read and follow these basic guidelines to help 

ensure your Word documents are accessible to all readers.  

Please note that if you produce information in formats other 

than Word, such as PDFs or flowcharts, you may need to 

provide a Word version of the same information as this may 

be the only way to make it fully accessible.  

 

The Importance of Headings 

The picture on the right shows a 

page from a document. Even if we 

can’t read it, we can see there is 

one large heading plus three smaller 

headings. 

We can tell at a glance that the 

document has one main topic and 

three subheadings within the topic. 

We recognise this information by 

scanning the page and the size of 

the headings provide us with a 

visual clue. We do not need to read the whole page to find 

the section that we are interested in and can use the 

headings to find what we are looking for. 
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Screen-reader software  

Visually impaired people using screen-reader software 

cannot quickly scan pages to pick out the information they 

need in the same way a visual reader can. Without properly 

formatted headings they are forced to read the entire 

document to find what they need. 

To make documents accessible, the most important thing is 

to create headings and subheadings in a way that are 

recognised by assistive technology. 

Headings are ordered. In the example of a book, we might 

say the book’s title is Heading 1, chapter titles would each 

be Heading 2 and topics within chapters will each be 

Heading 3 and so on. Screen-reader software will list all 

your headings together with their level and this allows users 

to quickly work out the structure of your document and find 

relevant content. For example: 

Heading 1 

Heading 2 

Body text 

 

Formatting Headings 

Visually impaired people rely on the use of headings to 

navigate their way through your document. We could make 

a heading stand out by increasing the font size, or using 

bold. This would certainly catch the readers’ eye if they can 

see it, but to assistive technology this appears no different 

from any other text in the document. 
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To create headings that screen-reader software will 

recognise, the text must be formatted using Microsoft's 

inbuilt 'Styles' menu, shown on the next page. 

 

Using the styles menu will not only give us the visual effect 

we want but it also ‘tags’ the text as a heading and allows 

the software to recognise it as such. It also enables you to 

create a table of contents if required.  

To create a heading, highlight the text and choose the 

Heading Style you want from the Home tab in the Word 

Ribbon as shown above. 

The default style settings will be too small for an accessible 

document, but you can easily change the font settings. 

Right-click any of the styles and select ‘Modify…’ and then 

change to the settings you need. 
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Font 

Fonts broadly fall into two categories ‘sans serif’ and ‘serif’. 

This document uses Arial, which is ‘sans serif’. This means 

it does not have the flicks or curls at the end of the 

characters which some people find harder to read. 

This is Times New Roman, a common example of a ‘serif’ font. 

You should use a ‘sans serif’ font whenever possible as 

these are generally considered easier to read on screen and 

in print. This is because the characters are simpler and 

easier to distinguish at a glance. 

Restrict your use of different fonts in a single document. It is 

acceptable to use a different font for headings and body 

text, but all headings should look the same and all body text 

should look the same. 

 

Text Size 

Diverse Cymru uses a 14 point font as standard, but 12 is 

also acceptable. Do not use a size less than 12 in any part 

of a document, including footnotes. 

Large print can be anything above 16 point. If you are asked 

to provide large print you should ask the individual for their 

preferred font and size, and ensure your document still 

works when re-sized e.g. Contents page matches actual 

pages in the text. 

 



8 

Colour and Contrast 

Always set the font colour to ‘automatic’ instead of ‘black’. 

Some visually impaired people usually use high contrast 

settings such as yellow text on a black background. If your 

font is set to ‘black’, then it will appear as black regardless 

of a user’s settings. If the text is set to be ‘automatic’, it will 

change according to each user’s preferences. 

If you do need to use a different colour for design or 

branding reasons, keep your palette as limited as possible 

and avoid multiple colours for headings or body text. 

 

Backgrounds 

Any background that has text over it should be a single 

colour, without pattern or texture. Ideally, ‘no colour’ should 

be selected so that users’ alternative settings can be used. 

 

Text on top of images can be difficult to read and should 

only be used when there is a consistent high contrast level 

between text and background. 
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Alignment 

Always align text to the left, do not centre or justify 

otherwise some readers will have difficulty finding the 

beginning of lines. Vertical text is not compatible with 

screen-reader software. 

 

Spacing 

Text can be difficult to read if the lines are too close 

together. Try to use a line space of at least 1.15. The ‘Line 

and Paragraph Spacing’ button can found on the 

‘Paragraph’ panel of the ‘Home’ ribbon on Word. 

Spaces can also be added before or after paragraphs via 

the ‘Page Layout’ tab. This document uses a 6pt space after 

paragraphs which helps define separations. 

Never use the space bar to create a line break or indents. If 

you need to indent text, use the ‘tab’ key. This will ensure 

consistent indents throughout your document. 

 

Content 

Include a table of contents if your document is more than a 

few pages long. 

Page numbers help a reader navigate through your 

document. Place them consistently on each page with at 

least size 12 font. 

Avoid using abbreviations. Spell out words like "and" instead 

of an ampersand (&) except when part of a company name 

e.g. "Marks & Spencer" or a standard abbreviation like A&E 



10 

(which would not include an ampersand if written in full, i.e. 

Accident and Emergency). 

Do not use ALL CAPITAL LETTERS except for recognised 

initialisms or acronyms such as BBC or RADAR. A large 

part of reading is simply recognising the shapes of words 

rather than reading each individual letter, and using capital 

letters makes this process much more difficult. 

When using an initialism or acronym for the first time, be 

sure to write it out in full, even if it is a commonly used term 

in your area of work. For example, the first time you would 

use “Black and Minority Ethnic (BME)” and after this you can 

just use BME. 

Underlining can make text harder to read for some users 

and can be mistaken for a hyperlink.  

Italics also reduce readability and should be avoided, the 

main exception being legal case citations that are 

traditionally italicised.  

Bold can be used for emphasis, but it should be used 

sparingly. 

If you need to separate words with a forward slash ( / ) 

always include a space either side of it as this makes it 

easier to read e.g. clear / large print rather than clear/large 

print. 

 

Bullets Points and Numbered Lists 

Bullet points and numbered lists are an excellent way to 

pass on information. They can be understood at a glance 
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and are often much simpler than a block of text. Review 

your work to see where these could be included. 

Bullet points and numbered lists can be read by screen 

readers, but make sure you introduce them with a 

descriptive sentence rather than rely on visual layout to infer 

meaning. 

 

Blank Lines and Hidden Formatting 

Even content that you cannot see is read out loud by 

screen-readers, and this can make documents confusing for 

the user. Paragraph Spacing and Page Breaks should be 

used instead of returns to create gaps between sections of 

text. Use the ¶ button, found on the ‘Paragraph’ tab of the 

‘Home’ ribbon, to reveal the hidden formatting in your 

document and delete all unnecessary spaces, returns etc. 

 

Headers and Footers 

Do not put important information in headers and footers as 

screen-readers may not be set to read them. 

 

Text Boxes and Tables 

Information contained in text boxes is not accessible to 

screen-readers. The software can handle tables better but 

these can be difficult to navigate as they often rely on visual 

layout to make sense, so include a concise explanatory note 

above complex tables to assist users. For example,  
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"The table below shows the total number of enquiries 

taken this year. There are 5 rows showing the type of 

enquiries dealt with and 12 columns, one for each 

month." 

Keep the text direction in tables horizontal, vertical text is 

difficult to read and inaccessible to screen-readers. 

 

Hyperlinks 

Use meaningful text for hyperlinks, do not use the file 

address or path name. Never just use words such as “click 

here” or “link”, instead use words that identify what is being 

linked to.  

Use ‘Diverse Cymru’s website’ instead of 

‘http://www.diversecymru.org.uk/’ 

Some assistive software lists the links in a document so the 

link itself must be self-explanatory without using any 

additional text. 

 

Text Only 

If you convert your Word document to Text Only format 

(.txt), ensure that you make any necessary changes to the 

plain text to compensate for the loss of formatting. Check 

that the content is still clear and understandable. 
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Images 

Images are not accessible to screen-readers and will appear 

as empty space so the user will not know if they are missing 

something important. Information should never be conveyed 

through images alone but they can be used to illustrate your 

words providing you add an alternative text description to 

the image.  

The screen-reader software will read the caption you 

provide in the 'Alt' Text box so the user will know what is 

being depicted in the image before moving on to the next 

block of text. 

 

How to use images 

Images should only be used to illustrate your text and not 
convey new information without explanation. 

When resizing an image, always do so proportionally. Never 
change the width or height without changing the other. This 
leads to images being squashed or stretched. 

Also be sure that your image is not too small to be seen 
clearly, or pixelated by being made too large. 

Ensure there is a reasonable clear gap between an image 
and text or the layout will look crowded. 
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Adding 'Alt' Text to an Image 

Right click on the image to open up the images menu. 

Select format picture then click the ‘Alt Text’ tab and type a 

description of the image into the box. 

  

Adding alternate text to images to PDF documents 

If you want screen readers to describe images in your 

document, you must provide the description.  

The alt text attribute lets you create alternate text that can 

be read by a screen reader. 

However, because a PDF file is fundamentally an image file, 

screen readers can have difficulty finding their way around 

and reading in the right order. They may be able to read the 
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text, but may not be able to follow formatting such as 

columns, boxes and captions. 

A Word document is preferable in most cases, however if 

you must use a PDF, please ensure the text is laid out as 

simply as possible. 

 

Using Alt Text in InDesign: 

1. Select an image that does not have alt text. 

2. With the selection tool, select the image. 

3. Choose Object > Object Export Options. 

4. Choose Custom from the Alt Text Source menu. 

5. Enter the description in the text field, and click Done. 

The alt text you entered is included whenever you export 

this InDesign file as an EPUB, HTML, or PDF document.  

However, it is not added to the metadata for the image file 

itself, so you'll need to re-enter it if you use the image in a 

different document. To ensure the alt text remains with the 

image, enter it as metadata in Adobe Bridge. 

You can import alt text: 

If alt text was entered for an image in Microsoft Word or 

Adobe Bridge, for example, you can easily assign the same 

text in InDesign. 

When you export the document, the alt text you've assigned 

will travel with the image.
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